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Developing a Layout Template for Digital References and Studies
By Francis Adams

Part VI

After planning the subject and content of your Digital Philatelic 
Reference or Study (DPS), important questions remain. “What 

should the layout look like?” “How can I make all the pages look 
the same?” “How can I re-use elements to minimize the effort?” “Is 
there a way to automate some of the work?” These main questions 
can be addressed through use of a master layout template.

A well-designed template keeps our design consistent by main-
taining a standardized format across all pages for the common ele-
ments within the study. This practice allows us to concentrate on our 
intent and creativity rather than the daunting task of adding every 
individual item manually and making sure the basic stuff works.

The following steps are meant to introduce concepts and meth-
ods. Additional bells and whistles are yours to develop in making 
your DPS and work unique. We’ll use basics from the pyramid 
structure outlined in Planning a Digital Reference and Study (TPC 
Fourth Quarter 2007) and some of the typeface, style, size and 
alignment information from Formatting a Digital Reference and 
Study (TPC First Quarter 2008) in designing our template.

Our Most Important Goal
Good layout and consistency function without notice.

Layout of a Content Page
It is important to visualize a page’s layout and be able to rearrange 
its components without being afraid you’re breaking something. 
An easy way to do this is to forget the computer for the moment 
and imagine we’re back in kindergarten.

Begin your layout development using common tools. A pencil, 
ruler, graph paper, and a few note cards will do nicely. Don’t be 
shy — break out that old crayon box with the blunt-end scissors.

Draw several squares or rectangles in various sizes and color 
them lightly in different colors. Make sure they’re not too small 
so they’re easily manipulated and cut them out like puzzle piec-
es. Let’s make a couple of small circles or ovals while we’re at it 
and color them as well (in different colors than the larger pieces). 
These pieces can be moved around and even overlapped. We’ll see 
how the pieces might fit together and how our layout might look 
and feel. It’s a very basic exercise with generally superior results as 
we are having fun and not worried about complex technology.

Next, let’s arrange the pieces to determine the size and place-

ment of the header, content, and footer for our content page layout. 
Remember, simplicity is good, but innovation is better. I’d like to 
encourage you to design and go beyond my strict block layout ex-
ample — it’s only a learning tool. As always, the choice is yours and 
block layouts are not bad things. Once the main pieces are in place, 
write the names Header, Content, Footer, etc. on them. (Fig. 1)

Fig. 1 Crayon Design Shop Results

We’ll also use PowerPoint’s default page layout for the ‘title’ 
page as it will differ from the layout of our content pages. You 
may decide to make additional layouts depending on the need for 
subsections, or special content in your study.

Congratulations! You’ve just designed a basic layout for your 
study. Put the crayons, ruler and the scissors away and get a 
snack — you deserve it.

Ready, Set, Power On
Words in Advance
We’ll use Microsoft PowerPoint simply because many people have 
access to it. Instructions will be limited to the necessary steps to 
build a basic template.

Note: The following instructions were developed using a Ma-
cintosh version of PowerPoint. Menus in the Windows version 
may not be exactly the same, but the methods will be very similar.

Hardware / Software
Ensure your computer is operable, has an appropriate version of 
Microsoft PowerPoint software installed, and that the program 
runs. (Phase 1 is complete.)

Continued on Page 5
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The Communicator 
Going Color in January

The Philatelic Communicator will become a full-color 
publication beginning with the first quarter 2009 issue at no 

increased cost for production or to Writers Unit #30 members. 
The upgrade will help to fulfill three goals — (1) attracting new 

WU #30 members and TPC advertisers, (2) giving the journal ad-
ditional eye appeal by eliminating the gray factor, and (3) being 
able to run articles dealing with color use.

The ability to run color will eliminate the problems that Fran-
cis Adams has encountered explaining use of color in his excel-
lent series on digital references and studies.

Readers can also expect to see articles relating to converting a 
publication to color, applying color to publication elements, im-
age editing, and philatelic-related digital photography. WU #30 
members are invited to submit articles relating to their experienc-
es in converting their publications to color and how they use it.

The old riddle was: “What is black and white and red all over.” 
The answer, of course, was a newspaper. The overall effect of black 
type and images on a white background was gray. In an ever 
increasing visually oriented world, even newspapers have been 
forced to redesign in color.

I can attest to the power of color. Circulation of the Federation 
of New York Philatelic Societies Stamp Insider has nearly doubled 
since it converted to color in May 2006. Positive reader and ad-
vertiser reaction to the Stamp Insider’s conversion to color have 
far exceeded my greatest expectations.	 ✒

Breakfast Cover
Noted stamp designer Chris Calle again produced the 
limited edition cover for the Writers Unit #30 breakfast 
at StampShow 2008 in Hartford. It features a cachet of 
Mark Twain, who lived in Hartford and the show cancella-
tion on the Albert Bierstadt stamp released at the show. 
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Peter Martin

President’s
Message

Peter Martin

My Message

APS AS
E / T
F –, 

A C C
Please join us for our 74th

Writers Unit Breakfast
8:30 a.m. Sunday, Feb. 22
Sheraton Arlington Hotel

⦁ Fraternity, Networking & Learning
⦁ More than 20 literature door prizes
Tickets $27 until Jan. 15 & $30 �ereafter

Call 814-933-3803 for Reservations

Speaker: Cheryl Ganz
Chief Curator of Philately

Smithsonian National Postal Museum
In addition to research and writing, Ganz has 
exhibited worldwide, including in the Court 
of Honor at Washington 2006 World Phila-
telic Exhibition. Ganz serves as co-editor of 
�e Zeppelin Collector, is a past president of 
the American Air Mail Society, and serves on 
the Ethics Committee of the American Phila-
telic Society. Her many awards include the 
Aerophilatelic Hall of Fame, the Fédération 
Internationale des Sociétés Aérophilatéliques Gold Medal for 
outstanding contributions to aerophilately, and the Newberry 
Award for contributions to Chicagoland philately.

Arlington, Texas

Y ’All Come!

StampShow Breakfast; 
Board Meeting Reports
The Writers Unit #30 breakfast at StampShow 2008 in Hartford 

was  another success, as more than 70 people attended . David 
E. Failor, USPS Executive Director for Stamp Services, provided 
an entertaining overview of the USPS stamp program. 

Hall of Fame members — Thomas J. Alexander, Pandelis J. Dros-
sos, Robert F. Dumaine, and Robin M. Startup — were inducted. 
StampShow literature awards were presented. Attendees received 
a commemorative event cover by stamp designer Chris Calle and 
specially cancelled stamps on the event program. Thanks to break-
fast chairman Steven Rod, attendees also received a copy of J. W. 
Scott’s Metropolitan Philatelist from the 1890s. He also put together 
the largest group of door prizes in recent memory with more than 
30 books, catalogues, and other prizes, valued at nearly $1,000.

The Board met after breakfast. Committee report highlights:
Awards: Robert Odenweller will provide draft of criteria and pro-
cedures for writing in non-philatelic publications by November 1.
Historian: Steven Rod is working with the president on a unit 
history; his first in a series of columns was published in TPC.
Literature Exhibitions: Jim Graue will provide a draft list of 2009 
literature exhibition to the editor by November 1 and ensure that 
a palmares for each event is provided to the editor.
Publicity: Ernest Fricks to provide a draft publicity plan for 2009 
by November 1.
Recruiting: Lloyd de Vries will present a 2009 recruiting plan 
by November 1. Plan to place added emphasis on reaching more 
people;, including a letter to all philatelic presidents and editors.
Special Events: Kennteh Trettin will present a 2009 round tables/
training/presentations at the two annual shows plan by November 1. 
Breakfast: Rod commended for outstanding job at StampShow.
Hall of Fame: 2009 nomination announcement to appear in the 
first quater TPC. Peter Martin will investigate obtaining a perma-
nent HOF plaque for placement in the American Philatelic Center.
Editor: Color to be added in 2009. Can always use more articles.
Bylaws: Katrina Everhardt is working with George Griffenhagen 

to finalize a draft for presentation to the board.
Web site: Andrew McFarlane needs input for updates.

New Business included discussions about the following:
New StampShow Medals: Will be reviewing ways to reduce the 
current $25 each cost without diminishing quality.
Secretary-Treasurer: The Board approved a special plaque for 
the secretary-treasurer for his 25 years of exceptional service.
2009 Election: Lloyd de Vries was appointed to fill the VP vacan-
cy left by the death of Barth Healey. 2009 will be an election year.
New Writing Awards: The awards chair to develop criteria that 
can be finalized by the February meeting.	 ✒



4	 The Philatelic Communicator

Short Takes
News & Commentary

Grammar Horror Alert!
The British supermarket chain Tesco used to have signs at its 

express checkout saying 10 items or less. Then grammarians 
complained, pointing out that the signs should proclaim 10 items 
or fewer. Tesco thought “or fewer” sounded awkward, and opted 
for new signs that read Up to 10 items.

But it is what happened next that makes this incident notable. 
The British Broadcasting Corporation recounted the Tesco af-
fair on its Web site (www.bbc.co.uk), and readers from around 
the world wrote to draw attention to grammar rules they see 
being flouted. Here are some of the best, in the readers’ words.
•	 … people suddenly seem to confuse have and of, as in: “I could 

of learnt how to write properly.”
•	 The proper use of its and it’s seems to confound many people, 

with its being a possessive and it’s being a contraction of it is.
•	 If you do something to change a situation, then you effect a 

change. If your circumstances are changed by an action, then 
the change has caused an effect. You cannot affect a change in 
something, nor can you be effected by one.

•	 Many … incorrectly use I instead of me. For instance, they say, 
“She said some very kind things about George and I.” An easy way 
to remember which to use is: If you would say him or her on its 
own, use me; if you would say he or she on its own, use I.”

•	 Incorrect use of reflexives make my blood boil. People will say 
yourself and myself when they just mean you or me. Those who 
use it correctly can give themselves a pat on the back.

•	 As a teacher, I’m beginning to despair when it comes to they’re, 
there, and their.

•	 I cringe when I hear reporters say amount of people when it 
should be number of people.
The editor’s pet peeves include:

•	 The media’s use of troops instead of soldiers in reporting deaths. 
A troop is a unit of soldiers that forms a subdivision of a cav-
alry or armored cavalry squadron.

•	 Misuse of over, which describes a spatial relationship: “The 
flag flew over the capitol.” More than expresses a numerical 
relationship: “More than a dozen  philatelists met at …”

•	 Insure and ensure — The former meaning to cover property 
with insurance, while the latter means to make sure or certain. 

“I would like to ensure that everyone is insured.”
What are your pet grammar peeves? What really makes your 

blood boil? Send us a letter or e-mail.	  ✒

Expert Help for Writers and Editors

Charles J. Peterson, Writers Unit #30 past president, offers 
free critiques of periodicals and books / manuscripts. Sub-

mit the four most recent issues, including postage equivalent to 
four times the first class mailing fee. Any unused amount will 
be returned. Critiques can be expected in about 30 days. In-
quire before sending books and manuscripts, providing a brief 
description. Return time will vary, depending on length and 
other commitments. Include a SASE. Send to Peterson at P. O. 
Box 5559, Laurel, MD 20226. His phone is 301-776-9822; e-mail 
cjp7777@aol.com.	 ✒

Backup! Backup! Backup!
All computer users should back up their data on a daily basis, in-
cluding e-mails, . I know a journal editor and a columnist whose 
computers suffered total meltdowns, forcing them to spend count-
less hours of resurrecting data. I also had two drive failures this year 
and was back at work within minutes. Why? I have a pair of mir-
rored external hard drives for data only and an automatic backup 
program. I also have an uninterruptible power supply that ensures 
no data is lost when — not if in Florida — the power goes out.

— Albert W. Starkweather

Casting a SPELL
The late Ernst Cohn talked me into joining SPELL (the Society for 
the Preservation of English Language and Literature), a non-prof-
it organization. It publishes an eight-page bimonthly newsletter 
with interesting feature articles on correct word usage, common 
grammatical errors, informative letters to the editor, mentions of 
new books such as dictionaries and thesauruses, and a Grammar-
Gram similar to a crossword puzzle.

One of the more humorous features is the two-page Murder-
ers’ Row center spread of items sent in by members when they find 
egregious errors of spelling or grammar in advertisements, news-
papers, magazines, and other media. Occasionally there are won-
derful, often tongue-in-cheek, articles by SPELL vice president and 
well known author Richard Lederer.

Details about the organization, including membership, can 
be obtained from SPELL, P. O. Box 321, Braselton GA 30517; 
www.spellorg.com; or spellgang@juno.com.

— Alan Warren

New Zealand Literature Exhibition
The 11th New Zealand National Philatelic Literature Exhibition 
will be conducted by the Manawatu Philatelic Society on June 27, 
2009 in Palmerston North. There are no entry fees or forms. Sub-
mission deadline is April 30, 2009. For more information contact 
Tony Thackery, secretary, at t.c.thackery@xtra.co.nz.

Dyslexia Never Has Been This Much Fun 
People calling a federal phone number to order duck stamps late 
this summer were greeted instead by a phone-sex line due to a typo. 
The carrier card for the stamp transposed two numbers. Instead of 
listing 1-800-782-6724, it listed 1-800-872-6724.

The first number spells 1-800-STAMP24, while the second 
spells out 1-800-TRAMP24. People calling that second number 
were encouraged by a husky female voice to “talk only to the girls 
that turn you on” — for $2 a minute. The Fish and Wildlife Service 
said it would be too expensive to reprint the cards at approximately 
$300,000. “That’s a lot of money we can be using for wildlife con-
servation,” said agency spokeswoman Rachel Levin.	 ✒
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Template — Continued from Cover

Laying the (File System) Foundation
Begin by making a new folder on your computer to hold all your 
study files and graphics. This new folder can be named anything 
you wish and may be stored anywhere you choose on your com-
puter’s hard drive or even on external media. The typical default 
location is usually the documents folder.
	 1.	 Click on the New Folder icon in the tool bar.
	 2.	 Name this folder My Famous Study (or a name of your choice).
	 3.	 Open this new folder and make another new folder inside it 

named Images. All your graphic images will be stored here.
Adding subfolders within My Famous Study to organize study 

materials guarantees you’ll know where things are when you need 
them. Organizational options include arranging files by file for-
mat (i.e., pdf or doc) or document type (i.e., interviews or refer-
ences). Ordering them by state is also an option — i.e., complete 
or finished. The arrangement is up to you, but using a system of 
some sort will make life easier later.

Reviewing PowerPoint’s Interface
Let’s crank up the PowerPoint software.
	 1.	 Locate and open the PowerPoint application on your computer.
		  Windows Start ▶ Programs ▶ MS Office ▶ PowerPoint.
		  Mac Mac HD ▶ Applications ▶ MS Office ▶ PowerPoint.
	 2.	 The PowerPoint application opens.
	 3.	 The Project Gallery screen appears.
	 4.	 Select PowerPoint Presentation.
	 5.	 Click Open ▶ Blank Documents.
	 6.	 A new document window appears and the screen displays a 

blank slide. The title slide layout is displayed by default with 
text blocks for the title and sub-title included. (Fig. 2)

Fig. 2 Project Gallery Window

This is the Normal View for PowerPoint documents and there 
are three panes visible in this view:
	 1.	 The Outline pane, left, which shows the thumbnail view of the 

slides in your study,
	 2.	 The Slide pane, right, the area for adding data (main area),
	 3.	 The Notes pane, bottom is for such information as file location, 

etc. Click in the window to add notes
The ribbon areas across the top and to the left hold menu selec-

tions and tool bars. (Fig. 3)

Fig. 3 Normal View with Three Panes

A series of small icons appears in the lower left of the main 
window. These icons allow the window display mode to cycle be-
tween Normal, Outline, Slide, Slide Sorter, and Slide Show views 
depending on which is chosen.

A Drawing toolbar may also be located at the bottom of the screen. 
If the toolbar is not showing, choose View ▶ Toolbars ▶ Drawing.

Our First Study
Let’s start with a basic PowerPoint file which we can modify using 
the screen we just opened.
	 1.	 Click on the 	Title text and enter the name of your study. (Fig. 4)
	 2.	 Click on the Subtitle text and enter the subtitle of your study.

Fig. 4 Title Page Template

	 3.	 Reposition or resize the text boxes as desired using the box 
handles, which are small squares in the corners and middle 
of the boxes.

	 4.	 Select the Title text and reformat it by setting the typeface, style, 
size, and alignment.

	 5.	 Repeat steps 3–4 for the Subtitle of the study.	
	 6.	 If a Copyright / Author / Date or other boxes are desired: 	

Insert ▶ Text ▶ Text Box
	 7.	 Repeat steps 3–4 for these boxes. (Fig. 5)

Continued on Page 6
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Fig. 5 Text and Repositioned Boxes

Template — Continued from Page 5
Save this file with a shortened version of the Title of your study. 

That way it will be obvious what it is, but it won’t be confused with 
other files. Ensure you’ve saved it into the folder My Famous Study.
	 8.	 From the main toolbar, select File ▶ Save As.
	 9.	 Name the file by typing in the File Name box.
	10.	 Select the location to save the file to in the Save In box. (This 

will be your new subdirectory folder in My Famous Study.)
	11.	 Select the file type in the Save as Type box ▶ PowerPoint (.ppt) 

format. (It may already be selected.)
	12.	 Click Save.

Note: Multiple column layouts are also an option. We are 
using the most basic layout to keep these instructions reason-
ably short.

Color Schemes
In this exercise, we’ll use a standard color scheme included with 
PowerPoint. These schemes match colors and shades for text, 
backgrounds, etc. so the overall look of the study is pleasant.

To coordinate our color scheme:
	 1.	 From the main menu, choose Format ▶ Slide Color Scheme. 

(Fig. 6)
	 2.	 Choose the desired option — White background, black text 

and blue highlights in this case.
	 3.	 Click Custom to see the itemized color settings.
	 4,	 Click Apply to All.
	 5.	 Select File ▶ Save from the main menu.

Note: Other options for slide design also appear under this 
menu choice. We’re only using the most basic of choices here.

Building a Slide Master
A Slide Master is the heart of our template and allows us to apply 
common, static items and styles to the entire study. We can set up 
text block positions, typefaces, sizes, styles and colors.
	 1.	 To insert a new slide to develop the slide master choose 

Insert ▶ New Slide.
	 2.	 To display the slide master choose View ▶ Master ▶ Slide 

Master. (Fig. 7)
	 3.	 The Slide Master appears. (Fig. 8)

Fig. 6 Color scheme panel

Fig. 7 Slide Master Selection from Menu

Note: The newer versions of PowerPoint have the ability to cre-
ate multiple templates. We’ll use only one to keep things simple.

We will always put our Section Title in the Master Title box.
	 1.	 Click on the Master Title box. (Fig. 9)
	 2.	 Reword the text to Click to edit page title.
	 3.	 Highlight the text and reformat the text typeface, style, size, 

and alignment.
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Fig. 8 Slide Master

Fig. 9 Master Slide Template

	 4.	 Reposition and resize the Master Title using the box handles.
	 5.	 Click on the Master Text box.
	 6.	 Reword the text to Click to edit content text.
	 7.	 Highlight the text and reformat the text typeface, style, size, 

alignment, and paragraph spacing.
	 8.	 Highlight the text and turn off the Bullets and Numbering.
	 9.	 Reposition and resize the Master Text using the box handles.
	10.	 Delete the Date/Time box in the lower left corner.
	11.	 Click on the Footer box.
	12.	 Reposition and resize the Footer box using the box handles.
	13.	 Delete the text <footer>,
	14.	 Enter the word Home followed by a double space and a pipe 

symbol (|) followed by another space.
	15.	 Enter the word ‘Introduction’ with a double space and a ‘pipe’ 

symbol ( | ) followed by another space.
	16.	 Enter the Section’ titles of the study followed by pipes and dou-

ble spaces between words.
	17.	 Enter the word References.
	18.	 Select all of this text and resize it accordingly to fit the box.

Note: We’ll return later and incorporate navigation hyperlinks.
	19.	 Click on the (page) # box.
	20.	 Highlight the # and reformat the typeface, style, size, and 

alignment as desired.
	21.	 Reposition and resize the # box as desired using the box handles.
	22.	 Select File’ ▶ Save from the main menu.

Using the Template
We’ll add a new slide for each Section of the study.
	 1.	 Choose Insert ▶ New Slide. The default layout appears, with 

our layout boxes in their correct positions.
	 2.	 Enter the desired text (subtitle, placeholder text, etc.) in the 

appropriate boxes. (Fig. 10)

Fig. 10 Add Pages for Each Section

	 3.	 Add slides for all ‘Sections’ of your study.
	 4.	 Select File ▶ Save.

One Size Does Not Fit All
In some instances, this basic template may not be exactly what’s 
required for all of your content and it’s not necessarily meant to 
be. The template is the lowest common denominator of your de-
sign and it is there to perform the grunt work so you don’t have to. 
Some modifications are to be expected. The template should be a 
helpful and flexible guide, not a rigid taskmaster.

The format of individual pages can be modified for specific 
content by re-positioning, deleting or adding boxes on a specific 
page to suit your needs.
	 1.	 Insert ▶ Text ▶ Text Box as desired.
	 2.	 Reposition and resize the new text box using the box handles’.

Conclusion
With our layout and template defined, our master plan is almost 
complete. Addition of a page and section navigation system will 
provide the ability for users to move from one section to any oth-
er section without going through every page sequentially to get 
to the desired destination. The next article will review how main 
section navigation can be incorporated into our document along 
with specific page movement. We’ll also embed links to draw on 
reference documents.	  ✒
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Handbooks and Style Guides for Philatelic
Authors and Editors: A Bibliography

By Brian J. Birch

Many philatelic publications find they need a style guide or 
style book to replace or enhance standard references. From 

my small collection of authors style guides and the like, I offer 
this compilation to assist and encourage others. The seed for the 
idea was planted by Kenneth Trettin: “Style Guide Smorgasbord,” 
The Philatelic Communicator, third quarter 2003, page 5.

Background
All writers must develop their own writing style. Otherwise the 
written word would be very boring, and it behooves all editors to 
bear this in mind when wielding their editorial pen. However, au-
thors generally write for more than a single publication and cannot 
be expected to know every aspect of each publication’s style. Ac-
cordingly, it is the editor’s duty to make such changes to authors’ 
works that enables them to merge seamlessly into their publica-
tion, following the same rules and adhering to the same criteria 
for language usage. Since this is a fairly monotonous and boring 
part of their activities, many editors have developed style guides for 
authors to encourage newcomers to do most of the donkey work 
prior to the editor receiving the copy for publication.

Author guides are not the same as house style guides or manu-
als and standards manuals that contain details of typefaces and 
sizes, paper size and weight, cover binding details, etc. to ensure a 
publisher’s output retains the same feel and appearance of its pub-
lications over many years and often through many editors and 
printers. These are not relevant here and often are not available 
to the public. Accordingly, they are not listed in this bibliography, 
unless such details have been incorporated into the guides listed.

Strictly speaking, author style guides add nothing to the 
process of creating the written work. However, one does not 
have to write many thousands of words before the uncertain-
ties begin to creep in: “What is the accepted way for this to be 
written?” or “How shall I best deal with that?”, and so on. This 
is where these guides help.

Introduction
As mentioned previously, authors’ style guides are used by editors to 
acquaint authors with the general rules they would like them to fol-
low in preparing their manuscripts. This usually includes such basic 
issues as subject matter relevant to the magazine’s audience; spelling; 
figures, photographs, tables, and references; and, finally, how the ed-
itors would like the manuscript presented to them. In other words, 
all of the information required by writers in order to minimize the 
editor’s time and effort in preparing their work for publication and 
to avoid the need for completely resetting the material.

For most specialized publications this will require just a few 
pages and up to a dozen or more for complex publications. How-
ever, major publishing houses that attempt to create guidelines for 
all eventualities and across all subject areas can see their docu-

ment grow to major proportions. The most notable of these is the 
Chicago Manual of Style, which has grown to nearly 1,000 pages 
and constitutes a virtual encyclopedia for writers.

Owing to the relative paucity of philatelic authors’ style guides, 
I have collected all that I have come across, regardless of where 
they were published. In particular, there is a growing trend to-
wards making these available on organizations’ Web sites. This 
has the dual advantages that authors can download a copy as re-
quired, saving the publisher the cost of having them printed and 
distributed, and that online documents can be updated easily so 
that the latest version is always available.

As well as philatelic style guides, I have also accumulated non-
philatelic style guides and other books specifically intended to aid 
writers and publishers in all matters relating to the conversion of 
words into print. For convenience, I have used the term writers 
handbooks to cover these publications. Like their philatelic coun-
terparts, they generally cover spelling, including capitalization 
and abbreviations; punctuation, including quotation marks; fig-
ures and numerals; and foreign languages. They also have a great 
deal of other useful information.

Since these are non-philatelic, I have restricted the listings to 
the few volumes that I have found useful over the years. Bear in 
mind that those listed are owned by me and may not be the cur-
rent edition. Two exceptions are The Chicago Manual of Style and 
The Associated Press Stylebook, both of which I have purchased 
recently on the basis of Trettin’s recommendations in his writ-
ings. The writers handbooks are listed in a separate section at the 
beginning of the bibliography.

The Bibliography
Note: Comments and data enclosed in square brackets are mine.

Handbooks
Austin, Tim, 1999. The Times Guide to English Style and Usage. 

London, UK: Times Books, 191 pp.
Burbidge, P. G., 1952. Notes & References, Cambridge Authors’ and 

Printers’ Guides IV. Cambridge, UK: University Press, 20 pp.
 ———, 1963. Prelims and End-Pages, Cambridge Authors’ and 

Printers’ Guides VII. Cambridge, UK: University Press, 30 pp.
The Chicago Manual of Style, 15th edition, 2003. Chicago: 

University of Chicago Press, 956 pp.
Goldstein, Norm, editor: The Associated Press Stylebook, 42nd 

edition, 2007. New York: Basic books, 419 pp.
Hart’s Rules for Compositors and Readers at the University Press 

Oxford, 37th edition. 1970. London, UK: Oxford University 
Press, 141 pp.

Montgomery, Michael and John Stratton, 1981. The Writer’s 
Hotline Handbook: A Guide to Good Usage and Effective 
Writing. New York: New American Library (Mentor), 383 pp.

Thatcher, Virginia S., 1997. English Usage and Style for Editors. 
Lanham, MD: Scarecrow Press,  165 pp.
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Style Guides
Style Guide for First Day Cover Cachet Catalogues, [ca. 1997]. 

Tucson, AZ: American First Day Cover Society, 15 pp.
Trettin, Kenneth, 2006. An Author’s Guide for the Congress Book 

2007. Rockford, IA: American Philatelic Congress, 8 pp. + 1 p. 
undated insert “Submitting Articles Prepared by Computer.”

 ———, 2004. A Style Guide for use by the Editors and Authors. 
Rockford, IA: American Revenue Association (American 
Revenuer), 20 pp.

Forand, Michel, March 1994. “Help! Authors submitting articles 
for the journal are requested to note the following guidelines.” 
United Kingdom: British Caribbean Philatelic Study Group 
UK: British Caribbean Philatelic Journal, Volume 34, Issue 1, 
p. 28. (See Herendeen below)

GSM Style (Gibbons Stamp Monthly), [Received in 1992]. 
Ringwood, UK: Stanley Gibbons Ltd., 3 pp.

Herendeen, David L., accessed October 24, 2008. “Guidelines for 
Authors.” http://www.bcpsg.com/author.html: British 
Caribbean Philatelic Study Group, UK. (See Forand above)

Jackson, Mike, January 1996. “Style Guide for the GB Journal” 
(Great Britain Philatelic Society.) Philatelic Writers Society, UK 
(disbanded): Philatelic Quill, Volume 12, Issue 1, pp. 13–17.

“Linn’s Writers’ Guidelines,” accessed October 24, 2008. Sidney, 
OH: Linn’s Stamp News, www.linns.com/aboutus/
writerguide/writers_guidelines.asp.

Scott Stamp Monthly Writers Guidelines, [Received in October 

	 1993]. Sidney, OH: Scott Publishing Company (Amos Press), 
12 pp. Editor’s note: Apparently out of print. (See “Linn’s 
Writers’ Guidelines” above.)

Monty, Richard A. and Allison W. Cusick, September 1982. 
“A Guide to Authors.” Society of Philatelic Americans 
(disbanded): S.P.A. Journal, pp. 39–44. (A brief comment 
on the guide was published as: “E. E. Fricks: A note on 
references,” S.P.A. Journal, December 1982, p. 258.)

“Proposed Stamp Lover Style Guide,” October 2006. London, 
UK: Stamp Lover (National Philatelic Society), Volume 98, 
Issue 5, p.127.

“A Sample Writer’s Guide from the BIA,” 1987. The Philatelic 
Communicator, Volume 20, Issue 2, pp. 27–32. Editor’s 
note: The BIA — Bureau Issues Association — is now the 
United States Stamp Society.

About the Author
Brian J. Birch, trained as a metallurgist, is responsible for health 

and safety for a large UK-based multinational company in the 
metal processing field. He began to collect stamps at the age of 8 
when his father introduced his elder brother to the hobby. By the 
mid 1980s, he had given up stamps and collected only philatelic 
literature, specializing in philatelic bibliography or the literature 
about literature. Anyone interested in his works, can find more 
on the Fédération Internationale de Philatélie (FIP) Literature 
Commission Web site at http://hps.gr/fipliterature.	 ✒

Addressing Writers Breakfast
Steven J. Rod addresses the Writers Unit #30 at APS 
StampShow 2008 in Hartford on August 17. He provided 
door prizes and other goodies for attendees.B
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Reviews
Print and Electronic

lector now has up to date and comprehensive information on 
U. S. postal cards.

The historical information presented is extensive and compre-
hensive and includes references to statutes and correspondence. 
This information is important in understanding the decisions be-
ing made and the large number of essays that were produced prior 
to 1873. The catalogue opens with a discussion of the forerunners 
and the Lipman postal card and concludes with the 1960 air mail 
post card with border. Coverage also includes postal reply cards, 
money orders and official cards.

Falberg kept the original classification system with only minor 
changes that are annotated in an appendix. The catalogue number 
is appended to a prefix to designate types of proof and other cards 
in a family. These are presented in table format in addition to the 
text and illustrations. The table also gives a short description and 
a catalogue value. Besides Scott numbers, the cards are also cross 
referenced to UPSS numbers in the new catalogue.

The illustrations are in black and white and generally of good 
quality. However, what makes this volume worth its price is the 
accompanying CD which offsets any disappointment when it 
comes to a lack of color. The CD contains a copy of the catalogue 
in Adobe pdf format with the images in color. As an added bonus 
the CD also contains a database with not only the 364 illustra-
tions contained in the book, but also an additional 653 images 
that did not make the book. 

The editors intend to use the CD as a library for future postal 
card essay proof images and to expand the database to include 
envelope essay and proof images. It can also be used for future 
updates for the book, although at this time it cannot be pur-
chased separately.

— Alfred Carroccia

CD Adds Value To Catalogue
Historical Catalog of U.S. Postal Card Essay and Proofs, Bill 
Falberg and Dan Undersander, editors. 384 pages with CD, 
8½ × 11 inches, case bound. ©2008 United Postal Stationery. 
$59 retail, $47 members from UPSS Publications, P. O. Box 
3982, Chester, VA 23831; www.upss.org. 

The United Postal Stationery Society (UPSS) is gaining the rep-
utation of publishing quality books in the highly specialized 

area of postal stationery and postal cards. This trend continues 
with the publication of its most recent effort that was released in 
August at APS StampShow 2008 in Hartford.

This compilation is a revision of a series of articles appear-
ing in the Essay Proof Journal written by Clarence W. Brazer 
and George C. Slawson. Brazer intended on combining these 
articles along with new research into a catalogue, but died and 
Slawson never completed the work. Falberg took the original 
manuscript and added or deleted material that he believed was 
appropriate for the new catalogue. He admits that being the 
editor gave him discretion as to what the content would be. The 
new material, along with updated historical information, make 
this work compatible with the U.S. Postal Card Catalog, also 
published by the UPSS. With both catalogues in hand, a col-

Books & Catalogues

Australian Air Catalogue Updated
Australian Air Mail Catalogue, Eighth Edition, Nelson Eustis 
& Tom Frommer, editors. 278 pages, A4 (8¼ × 11½ inches). 
©2008 A Page in Time, a division of Charles Leski Auctions 
Pty. Ltd., 13 Cato St., Hawthorn East 3123, Victoria, Austra-
lia; www.leski.com.au; contact@leski.com.au. Austra-
lian $120 for perfect bound or AU$150 for case bound, in-
cluding shipping worldwide.

Well-known Melbourne dealer Charles Leski has taken over 
publishing the famous Australian Air Mail Catalogue, re-

leasing the first edition in six years. It lists all airmails from Aus-
tralia and Papua New Guinea.

The first edition was published in 1937. Nelson Eustis died in 
2003 and this work was carried on by Tom Frommer, who has 
won large golds for his Australian airmail collection at interna-
tionals in 1996, 1998, and London 2000.

The publisher states:
“You will find it a dramatically enlarged and improved book. 

Firstly, it is in large A4 format.  This has enabled us to include 
many more illustrations. There are many new entries, with par-
ticular emphasis on intermediates which have previously been 
lumped together. Many errors and omissions in the older text 
have been found and corrected and, of course, the valuations 
have been updated. This has involved collating and studying 

thousands of prices from 
major auctions like Leski’s, 
Harmers, Bonham’s, Cherry-
stone, Gibbons, Prestige and 
others, as well as dealer’s lists 
and internet sales.”

The catalogue is laid out as 
follows: a list of Australian air-
lines, Australian first and spe-
cial flight covers listed chrono-
logically, rocket mails, pigeon 
posts, balloon posts, Papua 
New Guinea and special flight 
covers, crash covers. The ap-
pendices include Ross Smith 
covers, Australian pilots and 
important personalities index, Papua New Guinea pilots index, 
Australia airline index, Papua New Guinea airline index, Austra-
lian air mail postage rates, and an Australia air route map.

The new catalogue is very well done, and the illustrations are 
very good. I highly recommend it for anyone interested in Aus-
tralian aerophilately. 

— Ken Sanford
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Translation Opens Study Area
The Return Post of the Danish Postal Service by Kurt Hansen 
and John R. Sabin. 96 pages, 5½ × 8 ½ inches, perfect bound, 
card covers. ©2007, JRS Publishing. $35 postpaid to U.S. ad-
dresses, $45 elsewhere from John R. Sabin, 415 NW 23rd St., 
Gainesville FL 32607-2618.

This book is essentially the translation from Danish to English of 
five articles by Kurt Hansen. John Sabin translated the articles 

and added some comments and end notes, making this subject 
matter more widely available to collectors. The articles originally 
appeared in Nordisk Filatelistisk Tidsskrift, published by the Copen-
hagen Philatelic Club in 2004–2005. Hansen studied the handling 
of mail returned to the sender by the Danish postal service. Since 
he found little information in the literature, he compiled this re-
cord of the return labels or vignettes, the return resealing labels, 
and special return envelopes used by Denmark Post. 

The first resealing label was issued in 1878 and was to be used 
only on returned domestic mail. The 1890 issue had four print-
ings and thus more errors and varieties. Proofs also exist and the 
authors illustrate them. The labels sere printed in sheets of eight 
and the varieties can be identified by position. Each printing is 
also identified by perforations and color shade.

Similar detailed treatment is offered for the redesigned labels 
that issued in 1915, 1930, 1934, 1935, and 1964. Further designs 
were released in the latter part of the 20th century, but there is in-
sufficient information to date them accurately. An international re-
sealing label was also used to return mail from the dead letter office 
to the sender abroad. Again, the period of use is uncertain.

Readers will see a number 
of covers in fine color showing 
use of these resealing labels. 
Also illustrated are several ex-
amples of special return enve-
lopes in which the original let-
ter was enclosed and addressed 
to the sender, often without 
additional postage required.

The final chapters describe 
various labels with specific in-
structions such as Unknown, 
Not Collected, Forbidden, De-
ceased, and Insufficient Ad-
dress used for the return of in-
ternational mail.The authors 
describe the printing of such 
labels in sheets and strips.

An appendix illustrates multiples of the domestic labels in 
blocks and strips. Some attempts at cataloguing were done by AFA 
and Facit, but the most complete listing is that of Scandinavian 
dealer Jay Smith. A table relates the three numbering systems to 
one another. The book ends with a glossary and reference notes.

Postal historians of Danish philately will gain a better under-
standing of the special treatment of mail described in this book. 
The color illustrations are excellent.

— Alan Warren

Handbook Expands on Catalogues
South African Airmails by Nicholas Arrow. 203 pages, perfect 
bound cover, A4 (8¼ × 11½ inches), color illustrations. ©2008 
published by author, Musbury, United Kingdom. £30 (approxi-
mately $58) plus £10 ($19) airmail postage worldwide.

There have been three definitive catalogues of South African Air-
mails published since 1936. The first was The Airposts of South 

Africa by L. A. Windham, the second was South African Airmails by 
Capt. Milton F. Stern, published in the late 1960s, and the third Par 
Avion in Southern Africa by John T. Burrell, published in 1986. Each 
of the second and third catalogs expanded on the earlier ones.

This latest handbook, although it is not really a catalogue as 
it does not include pricing of covers, expands considerably on 
all three earlier catalogues. The first chapter covers pioneer and 
other special flights to August 31, 1939. It is written in narrative 
style. The volumne includes a chronological listing of the flights 
and assigns a rarity factor of covers from each flight.

The second chapter covers internal scheduled flights through 
August 1939 and is in the same format, starting with the narra-
tive, followed by a chronological listing of the flights. However, 
the rarity factor of covers is not shown in this and most of the 
subsequent chapters. The third chapter covers external scheduled 
flights to August 1939 in the same format.

The fourth chapter covers the war years and includes the Horse-
shoe Route —  mail between South Africa and the U.S., crash mail, 
air letters, aerograms and airgraphs, and a chronological listing of 
mails flown from September 1, 1939 to September 30, 1945.

The fifth chapter covers the post-war era through May 31, 1961, 
and describes the first flights of various airlines that have served 
South Africa, such as BOAC, KLM, Pan Am, Air France, Swiss-
air, Sabena, and Qantas. This is also followed by a chronological 
listing of the flights between October 1, 1945 and May 31. 1961, 
where again the rarity factor of covers is resumed. 

Chapter six covers the period June 1, 1961 through 1974, then 
1975 to 1981, where the rarity factor again is dropped. Finally the 
period 1982 to February 7, 1994 is covered in both the narrative 
and a chronological listing. 

There are a number of appendices which cover:
•	Dates of intermediate or government experimental
	 service flights;
•	Note as to Rand Airport, which served Johannesburg
•	 A list of well known and prominent people to which many first 

and special flight covers are addressed
•	 Balloon and Helicopter, etc. flights
•	 Antarctic helicopter flights

Throughout the chapters, some covers are shown in color, but 
the illustrations are not as numerous as in Par Avion in Southern 
Africa, which this reviewer would have liked.

Also, there is no bibliography, which would have been useful. 
The rarity factor should have been used throughout the listings 
as well.

Overall, the handbook is very well done and it is a valuable 
addition to the literature on South Africa Airmails.

— Ken Sanford
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New Michel Catalogues
Michel catalogs are published in Germany in 152 × 203mm (6 × 8 
inches) perfect bound format with mostly color illustrations in the Eu-
rope series and black and white illustrations in the overseas series. All 
text is in German, but the clear illustrations and format make them 
easy for anyone to use. Values for mint, used, on cover and FDC items 
are provided in euros. They may be ordered through the Michel Web-
site — www.michel.de. For North American retail prices, contact 
the U.S. distributors, Lighthouse Publications, 274 Washington Ave., 
Hackensack, NJ 07601; www.lighthouse.us or Lindner Publica-
tions, P. O. Box 5056, Syracuse, NY 13220; www.lindner-usa.com.

Michel 2008 Austria Specialized Catalogue. 576 pages. The pub-
lisher’s list price is 46 euros. 

This catalogue has become an indispensable reference for Aus-
trian philatelists. The editors have continued to add to each suc-

ceeding volume, and this edition adds 84 pages of Austrian postal 
stationery for the first-time inclusion. Postal stationery is an impor-
tant addition and features postal cards; pneumatic mail postal cards; 
postal savings cards; tax, telegram and telephone issues; lettercards; 
reply cards; aerogrammes; special events cards, and stationery. Most 
of the illustrations in this section are black and white.

The catalogue is comprehensive and includes: regular issues 
through the January 18 WIPA stamp. The entire range of Austrian 
issues from 1850 forward is covered, including Austria-Hungary; 
Austria as part of the German Reich; Austrian Republic; Lombar-
di and Venicia; Austrian offices in Crete, the Levant and China; 
Bosnia and Herzegovina; ship mail; and field post offices. The vast 
majority of the nearly 5,500 illustrations are in full color. 

Also listed are more than 100 new issues and special items, in-
cluding the non-issued 2005 Dalai Lama stamp. Other additions 
are the newly identified varieties of the 1934 Dollfuss stamp, im-
proved stamp booklet illustrations and the inclusion of circular 
number postmarks for the registered mail listings.

Based upon the listed values, the Austrian market is stable, 
with increases noted in specialized areas like stamp varieties; 
miniature sheets and small-format sheets issued since 1990; and 
postal history. Values for Europa (CEPT) stamps are trending 
downward, in some cases significantly so. 
Michel 2008 Switzerland–Liechtenstein Specialized Catalogue. 
576 ppages. List price is 46 euros. 

This catalogue has been upgraded to include 71 pages of postal 
stationery, with mostly black and white illustrations. covering 

both countries. The comprehensive catalogue has more than 4,200 
color illustrations and includes Swiss issues through November 20, 
2007, and Liechtenstein issues through November 19, 2007.

The new postal stationery section includes postal cards, official 
and semi-official postal cards, special event cards, lettercards, air let-
ters, and stationery. In addition to the stationery listings, highlights 
include: Swiss Canton issues, vending machine stamps and tickets, 
booklets, coils, official stamps, postage due stamps, telegraph stamps, 
air mail issues, locals, military mail, international organizations and 
Campione, as well as Liechtenstein vending machine stamps, offi-
cial stamps, postage due stamps, and field post offices.

Noted were numerous value increases, particularly for Swiss 
airmail and official stamps, League of Nations issues, International 
Labor Organization issues, especially on cover, and Pro-Juventute 

stamps. Europa issues had slightly lower values. In general, the is-
sues of the Principality of Liechtenstein have remained stable.
Michel 2008 Central Europe Catalogue (Europe Volume 1). 
1,216 pages. List price is 48 euros. 

The Michel Europe catalogues are the standard reference used by 
European philatelists. The detailed listings and easy to use for-

mat make it the popular choice for collectors seeking the most up-
to-date values. Volume 1 covers Central Europe, including Austria, 
Czechoslovakia, Czech Republic, Hungary, Lajtabanat   (West Hun-
gary), Liechtenstein, Slovakia, Switzerland and UN Geneva and UN 
Vienna. Issues up to the end of January 2008 are included. There are 
nearly 14,000 color images and more than 64,000 revised values. 

Included in the listings is the unissued 2005 Austrian stamp to 
mark the 70th birthday of the Dalai Lama. It is a modern Austrian 
rarity and is valued at 1,000 euros. This area of Europe has seen 
an upward spiral in values, with many increases of 100 per cent or 
more. Examples include Austrian postal history and FDCs, numer-
ous 1939–1945 issues from Slovakia and some Swiss issues. 
Michel 2008-2009 Deutschland (Germany) Katalog. 1,104 pag-
es. List price is 36 euros.

Michel’s standard Germany catalogue, akin to the U.S. listings 
in the Scott Catalogue Volume 1, is reasonably priced and or-

ganized by German collecting areas with chronological listings. Spe-
cial stamps, such as officials or postage dues, are found at the end of 
each collecting area. A comprehensive index listing overprints and 
stamp inscriptions and survey lists of definitive issues is provided. 

The Deutschland Katalog contains classic and modern German 
stamps though May 12. The catalog is divided into collecting areas 
such as: Old Germany, the North German Confederation, Ger-
man Empire, foreign post offices, colonies and ship post abroad, 
occupation issues of the First and Second World War, plebiscite 
areas, Belgian military post in the Rhineland, Gdansk, Memel, 
Bohemia and Moravia, General Government, Sudetenland, field 
post stamps, local issues, Allied Occupation (joint issues, Berlin 
and Brandenburg, Soviet Occupation Zone, French Occupation 
Zone, American and British Occupation Zone), German Demo-
cratic Republic, Berlin (West), Saarland, Federal Republic of Ger-
many, and Saarland as a federal state of the FRG.

Highlights in this edition include detailed information about 
definitives, commemorative stamps, variable-rate stamps, book-
lets, official stamps, postage-due stamps, registration stamps, air-
mail stamps and more; survey lists of miniature sheets and defini-
tive series; Lists of year sets with values based on dealer offers; A 
comprehensive section regarding expertization; a list of contact 
addresses for study groups; An updated keyword index in the ap-
pendix; More than 9,600 color images and nearly 59,000 values.

Noteworthy is the inclusion of a CD that is mounted in the 
catalog: MICHEL-Rundschau 2007, MICHELsoft easy and ABC 
search lexicon for FRG, Berlin and GDR.

This volume features a complete revision of the 1914–1918 Ger-
man occupation issues. Many value increases were noted, especially 
for Upper Silesia, Gdansk postage due stamps, Port Gdansk, Bohe-
mia and Moravia, General Government, and World War II occupa-
tion issues. There were some lower values, such as for the CEPT is-
sues. The average collector will find this catalog more than adequate; 
specialists will prefer the Michel Germany Specialized Catalogue.

— Peter Martin
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Journals & Newsletters

Paying Attention

Ralph Weil, editor of The China Clipper, the journal of the 
China Stamp Society, changed the format of the journal 
from one column (used for 72 years) to two columns. He 

read the review in The Philatelic Communicator and heeded 
the suggestion to switch to two columns. 

Briefly Noted
The Precancel Forum is published monthly by the Precancel Stamp 
Society, Inc. Editor: Larry Patterson; www.precancels.com. 

Precancel collecting is just as popular today as it was 50 years 
ago. If you thought there are no more varieties of bureaus and 
locals to be found, think again. The PSS employs an army of re-
porters to classify and count town and types as noted in the The 
PSS Town & Type Catalog of the U.S. & Territories. A good portion 
of this journal is devoted to publishing counts and reporting new 
finds, several of which are enthusiastically described and illustrat-
ed, in color. This method is a unique way to involve the member-
ship in a meaningful and enlightening philatelic task beneficial 
not only to the PSS, but also the hobby as well.

There is an even mix of specialized and general articles 
geared toward the novice collector. Dilmond Postlewait is to 
be commended for authoring an excellent and straightforward 
primer on the basics of precancel collecting. Another short 
piece walks the reader through The PSS Town & Type Catalog 
and its unique classification system. Rounding out each issue is 
detailed news from different club chapters and many individual 
adlets from members on everything precancel. This is an excel-
lent publication.
The Old World Archæologist is published quarterly by the Old 
World Archæological Study Unit. Editor: Caroline Scannell. 14 
pages, 8½ × 11 inches, stapled; www.owasu.org.

The appearance of this important journal being stapled 

would lead the reader to believe it is a newsletter with no sub-
stantive information. However, the colorful masthead and a 
lead article telling the story of Hadrian’s Wall complete with 
illustrations of stamps in color jump out to draw the reader 
into this exciting topical area. This journal packs a treasure of 
both philatelic and non-philatelic information from the world 
of archæology.

The editor and authors do a fine job of keeping a balance 
between philatelic and scientific information. Illustrations in-
clude stamps, covers and artifacts all in color. The illustrations 
are scanned clearly and easy to see details. Each issue also con-
tains a comprehensive survey of recent issues related to archae-
ology. (See the next page for a review of its Web site.)
The Czechoslovak Specialist is published bimonthly by Society 
of Czechoslovak Philately. Editor: Ludvick Svoboda. 44 pages, 
journal format, saddlestitched; www.csphilately.com.

A glance at the table of contents of a recent issue of this jour-
nal was enough to draw my attention. An article titled “The O. 
J. Simpson of Czech Philately” is enough to turn heads! It is an 
interesting, but disturbing, story of two Czech collectors accused 
of selling forged Czech material. One of the accused even had 
the audacity to testify at his trial that he was not aware any of his 
material was forged. The court believed him and he was acquitted 
of all charges.

This journal covers all the different areas of Czech philately 
from its birth to its present status as Slovakia and the Czech 
Republic. Articles include a serialization explaining the myriad 
of varieties of arch types of the fifth design 25h Hradcany is-
sue. An exhaustive survey it outlines all the plate varieties and 
painstakingly describes each variety in minute detail. It is lav-
ishly illustrated. However, the illustrations are poor and details 
difficult to discern. It is a problem throughout the issues; even 
photographs are poorly reproduced. Other articles were re-
prints from other publications.

— Alfred Carroccia

Putting on a New Face
After becoming editor of Vatican Notes earlier this year, Dan-
iel A. Piazza has gradually freshened its appearance, starting 

with replacing the former front 
page (left) with a true cover. 
While retaining the name-
plate’s basic design, he then 
replaced the English deriva-
tive Shelley Adante font with 
a bolder Italian-influenced 
chancery font. The new cover 
highlights a single article. The 
sparse table of conents has 
been elminated in favor of 
bottom-of page promos. Vati-
can Notes is the journal of the 
Vatican Philatelic Society.
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Electronic Media & Software

Exploring Archæology Online

The purpose of the Old World Archæological Study Unit, ac-
cording to its Web site, www.owasu.org, is to “collect and 

study postage stamps related to archæology (and cultural anthro-
pology for spice) from the stone age to the beginnings of recorded 
history.” The Web site is seeking a volunteer Webmaster.

The site’s pastel yellow backdrop is accented in blues and reds. 
Black sans serif text is extremely readable. Top-of-page tabs make 
navigation easy. The new digs tab shows the latest additions, many of 
which link to on- and offline articles and bibliographic information. 
There is also a section for members, novices, library, and a freebies 
section. The gallery is the best section, having links to many stamps 
and postal history examples split into study areas — prehistoric, Ro-
man, Egyptian, old world, Pacific, African, and Asian cultures, mu-
seums, and famous anthropologists, scientists, and archæologists.

The link, www.owasu.org/gallery_pics/france02.jpg, un-
der the cave art category brings up an interesting registered cover 
from France franked with cave painting stamps and a Europa key 
stamp. A fascinating Kenyan first day cover is signed by Rich-
ard Leakey, www.owasu.org/gallery_pics/leakey02.jpg, pa-
leoanthropologist son of Mary and Louis Leakey. 

If your grandchildren are interested in ancient civilizations or 
like the Disney movie Hercules, you might get them hooked on 
stamp collecting using the Hercules checklist in the freebies section. 
The free checklist can be downloaded as text or in pdf format. It is a 
comprehensive list of Herculean stamps from more than 20 coun-
tries. A similar list is provided for Nubian Monuments on stamps.

The library section contains an informative and comprehensive 
bibliographical list of  information related to old world subjects, 
including catalogues, e-books, articles in related philatelic mag-
azines, atlases, books, and the OWASU journal, The Old World 
Archaeologist. (See previous page for a review.) Live links are avail-
able for publications that can be purchased readily online.

The site has a great deal of helpful information for the average 
collector. Sadly, the group’s efforts to reach out to others through the 
site will likely disappear without a Webmaster to keep it updated.

— Heather Sweeting

A Virtual Meeting Place

The Peru Philatelic Study Circle was formed in 2006 as a virtu-
al meeting place for those interested in that country’s stamps 

and postal history. The www.peru-philatelic-study-circle.
com site explores different facets of Peruvian philately.

Many specialized societies have turned to the Internet. Some 
use it as a supplement to society offerings, such as images and in-
formation not otherwise offered through printed material. Com-
munication is the key to Internet use as societies employ it as an 
instantaneous link between the society and current and future 
members. Is a virtual club cursing its very existence by gambling 
on the internet as its primary medium, shutting out those collec-
tors without access to a computer?

An elaborate listing of all postmarks from different states spans 
the period from the 1800s through the 1950s with clear illustra-
tions and detailed annotations for each marking. This project is 
being updated continuously as new discoveries are added and cur-
rent information updated, an almost impossible task if the project 
was published on paper. Other virtual projects include a study of 
security seals for certified mail in 1916 by Henry Marquez and a 
philatelic presentation of the war in the Pacific by Richard Abrams. 
Both projects are highly specialized and the information intricately 
detailed and spread out given the expanse of the web site. 

A virtual expo allows instant access to excerpts from gold 
medal exhibits that are otherwise inaccessible to collectors to 

view in person. Links to Peruvian philatelic, non-philatelic and 
ephemera are numerous and useful. 

A useful tool for the specialist, this site can use improvement for 
the general collector. Nowhere is there information for the beginner 
or any type of general survey of Peruvian stamps or postal history.

— Alfed Carroccia
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Material for reviews may be sent to the editor. Reviews are also 
welcomed from others. Reviews should be concise and stress 
those aspects that are helpful examples (positive or negative) 
for other authors, editors, and publishers. Review requests from 
those having an interest in the item, such as publishers and dis-
tributors, must include a copy of the publication.	 ✒

Across 
2. Stamp handler 
6. Roswell sight 
8. USPS predecessor 
10. A sign of use 
11. On a roll 
13. Wedding companion 
15. Intact envelope 
17. Friar‘s Club event 
18. Postal clerk time saver? 
19. Offensive smile 
23. Drain 
25. Receptacle for ashes 
26. This needs scissors 
27. Type of therapy 
30. Early diesel switch locomotive 
31. Like a waffle? 
33. Not definitive 
34. First day cover feature 
35. Coated with phosphor 
36. Everyday postage 
37. Bene predecessor 
38. Longest running British stamps 
41. Stamp modifier 
43. Hinge alternative 
44. Not eye to eye 
46. Not mint 
47. Hairy ox 
48. Speedy delivery method 
51. Printers’ signature 
53. Estimate weight 
54. Israeli stamp feature 
55. Shakespearean king 
58. Never mounted 
59. Three for one? 
60. Overseas airmail designation 
61. Zone successor 

62. Central image 
63. Plaster companion
 
Down 
1. Farley‘s follies feature 
2. Specialized collection 
3. Diving sea bird 
4. Acronym for newly issue stamps 
5. Respond 
7. Hidden I.D. 
9. Like Canadian stamps 
12. Wish you were here item 
13. Handy small block 
14. A change in valuation 
15. Characteristic of some
    Third World stamps 
16. Plane on first U.S. airmails 
20. Two of a kind 
21. Stamp divider
22. Acronym for copies 
24. Homebody mail 
28. Stamp assassin 
29. Joined, but not equal 
32. Retouched plate 
34. Desirable stamp trait 
36. Tee off
39. Two-color printing error 
40. Mail staying close to home 
41. Famous tentmaker 
42. Revenue stamp separator 
45. On the nose 
48. Stamp repository 
49. Conservative Limbaugh 
50. Prayer ender 
52. Theft deterrent 
56. Fresh stamp 
57. Result of peeling?

An Easy Crossword Creator
Crossword Forge 5.5.1 by Cortis Clark, www.solrobots.com. 
Mac OS X 10.1 and higher or Windows 98 and higher. ©2008 Sol 
Robots LLC. Download $49.95 ($48.95 PayPal); CD $15 extra.

I have found that crossword puzzles are a popular feature with 
most readers and provide a welcome break from more traditional 

philatelic entertainment, such as quizzes. The main drawback was 
that they usually are quite difficult to construct. Enter Crossword 
Forge, which makes the task nearly painless, Type in clues and an-
swers, run the built-in spell check, and hit the make puzzle button.

The program, which was created as an educational learning 
tool, has some notable differences from traditional crossword 
design — adjacent blocks of answers cannot be created and the 
puzzle creator cannot override the program’s automatic generator 
to add words manually, a small price to pay for its ease of use.

One of the more interesting features is the choice of backdrops: 
none, traditional solid, or an image. How many programs sup-
port English, French, Spanish, German, Italian, Russian, Swedish, 
Portuguese, Dutch, Greek, Scottish-Gaelic, Afrikaans, Japanese 
(Hiragana), Japanese (Katakana), Chinese (Simplified), Chinese 
(Traditional), Punjabi, and Esperanto? It also creates word finds. 

As the number of clues increases, so does the time it takes to 
generate the puzzle. The example here took nearly eight minutes, 
conveniently allowing time for the editor to take a break.

The biggest problem is the limited number of formats in which a 
puzzle can be saved — as an image, as text, as a pdf, or as an inter-
active online puzzle. The built-in image and pdf generators are lim-
ited to 72 dpi, too small for print reproduction. The print dialogue, 
however, offers a better PDF generator. I save the pdf file as an eps 
file that can be resized and saved in Adobe Illustrator.

I would expect that this issue will be resolved at some point, 
as there have been more than 162 version revisions to date. I ac-
quired the program in 2004 and am still getting free updates!

— Albert W. Starkweather
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StampShow 2008 Literature Palmares 
StampShow 2008 literature award winners have 

been named. Judges at the August 14–17 event 
in Hartford, CT, were John M. Hotchner, chair; 
John Kevin Doyle; and Roger P. Quinby. 

Grand Award
U.S. Contract Mail by Water (Star Routes 1824–1875), 

Collectors Club of Chicago, publisher; Hugh V. 
Feldman, author

Reserve Grand
Letter Mail From and To the Old Italian States 

1850–1870, Vaccari Srl; Mario Mentaschi and Thomas Mathá, 
authors

Japanese Philately, International Society for Japanese Philately; 
Robert M. Spaulding, editor

Articles and Columns 
Gold 
Postal History of Trinidad 1792–1898, American Philatelic 

Congress; Reuben A. Ramkissoon, author

Vermeil
The Apollo 11 10¢ Air Mail Issue: Analytical Study of the Stamp, 

Cachets and Cancellations, Parts I, II, and III, AFDCS; 
Reuben A. Ramkissoon, author 

Collection of Articles Published in the EFO Collector, July 
2005–December 2007, EFO Collector; Joseph Monteiro, author

Philatelic Bookshelf, Canadian Stamp News, Michael O. 
Nowlan, author

Silver 
Spécial Vélos sur Timbres, www.philateliequebec.com; Guy 

Derosiers, author 

Catalogues 
Gold 
Classic Romania, David Feldman Auctions publisher
Unificato Di Storia Postale, C.I.F.–Srl, editor
Vaccari Catalogue 2008–2009 — Postage Stamps and Postal 

History. Historical Study and Catalogue with Valuations, 
Vaccari Srl; Paolo Vaccari, editor

Vermeil
Christmas Seal Buttons, Pins and Medals of the U.S. (CD), John B. 

Denune; Louis Caprario, author
Green’s Catalog of Canadian Local & Provincial TB Seals, John B. 

Denune; Cliff Beattie, editor
Green’s Catalog, Part 1, U.S. National Christmas Seals, John B. 

Denune; Dick Green, editor
Levy’s Boy and Girl Scout Cachet Covers of the United States, 

SOSSI; Jay L. Rogers, editor

The Precancel Stamp Society’s Town and Type 
Catalog of the United States and Territories, 7th 
Edition,  Precancel Stamp Society; Arnold 
Selengut and Phil Cayford, editors
A Supplement to Green’s Catalog of TB Seals of the 
World, John B. Denune; Charles Hoger, editor

Silver 
The International Award Medal Exhibit China First 
Flight (1920–1940) Formed by Mr. Tatsuya Abe, 
David Y. Lu, editor 
Newfoundland: The Harvey Poole Collection, Eastern 

Auctions; Yohann Tanguay and Luc Doucet, editors
Selected Rarities / Catalogue III, Gary Lyon (Philatelist); Yohann 

Tanguay and Luc Doucet, editors

Silver Bronze 
A Specialized and Comprehensive Catalogue of the Exporta Issue 

of Mexico, John R. Endsley, Jr., editor

Handbooks and Special Studies 
Gold 
Carpatho Ukraine — Postal History and Stamps 1786–2000, 

Dutch Society for Czechoslovak Philately, Jan Verleg, author 
The Congress Book 2007, APC;  Kenneth Trettin, editor
Intercepted in Bermuda, Peter A. Flynn, author
The Liberty Series, American Philatelic Society; Ken Lawrence, C. 

David Eeles, and Anthony S. Wawrukiewicz, authors
Stamps On Music — The World-Wide Catalogue & Handbook of 

Stamps Issued Under Copyright Acts, Adam Miller, editor 
U.S. Contract Mail by Water (Star Routes 1824–1875), Collectors 

Club of Chicago; Hugh V. Feldman, author
Camp Genter: Colorado Ghost Town Mail, Rocky Mountain 

Philatelic Library; John Willard and Sergio Lugo, authors
Canadian Postage Stamp Errors of the Queen Elizabeth II Era — 

Vol. I to Vol. III, Joseph Monteiro, editor
Letter Mail From and To the Old Italian States 1850–1870, 

Vaccari Srl; Mario Mentaschi and Thomas Mathá, authors
Revenue Stamped Paper of Mexico 1821–1876, Donald O. Scott 

and Frank A. Sternad, authors
United States Patriotic Envelopes of World War II, James E. Lee 

Publishing; Lawrence Sherman, author

Vermeil 
The 2007 Pricing Guide for Unlisted Carriers, Locals, Fakes, Forgeries 

and Bogus Posts of The United States, Larry Lyons, editor
America on the Map, CartoPhilatelic Society; Miklos Pinther, editor
Annotated Bibliography of Cuban Philatelic Literature — Internet 

Edition, www.philat.com; Ernesto Cuesta
Bellefonte and the Early Air Mail 1918–1927, American Philatelic 

Society, Kathleen Wunderly, author
El Quetzal Volumes 1–56 (DVD), International Society of 

Guatemala Collectors’ Eric Dyck, editor
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Forgery Guides for the Soviet Issues for Armenia 1922–1923, R. J. 
Ceresa, author

Icelandic Numeral Cancellation, The Society of Icelandic 
Collectors; Leif Nilsson, editor

Nazi Germany & Fascist Italy Propaganda Postcards, Volume 1, 
RJI Publishing; James A. Lees, author 

Onward Air Transmission (O.A.T.) and A.V.2 Markings, American 
Air Mail Society; Murray Heifetz, author

The Postage Stamps of Clipperton Island, Wolfgang Baldus, author
The Postage Stamps of the Pao Tzu Ku Bandit Post, Wolfgang 

Baldus, author
Postryttaren Årsbok för Postmuseum 2008, Swedish Postal 

Museum; Jan Billgren, editor
U.S. Revs — Perfins (A Handbook of Perforated or Punched 

Initials, Numbers and/or Designs in United States Revenues 
and Fiscal Documents), Arthur J. Mongan, author

Winfred M. Grandy — A Philatelic Biography (CD), Joseph P. 
Connolly and Sean P. Connolly, authors

Silver 
Cumulative Index for Newsletters and Postal Himal Issues 

1–132, Nepal and Tibet Philatelic Study Circle; Richard M. 
Hanchett, editor

Deception Island Antarctica‚ An Historic and Philatelic Record, 
Stephen Pendleton, author

Filacuba Internet Website, www.philat.com/FILACUBA; 
Ernesto Cuesta, Webmaster

German Propaganda Parodies Against Great Britain, Wolfgang 
Baldus, author

“Greetings” Postal History of the Selective Service & the Draft 1917 
to 1976, Military Postal History Society; Russ Carter, author

Postal Cards and Aerogrammes of the Vatican City State 1929–2007, 
Albert A. Antonellis, author

The Return Post of the Danish Postal Service, John R. Sabin, author
Stamps of Egypt (Book 2), Leon Balian, author
Using a Town and Type Catalog to Start a Precancel Stamp 

Collection, Larry Patterson, author
Vermont DPO Guide 2006, Vermont Philatelic Society (VPS); Bill 

Lizotte, editor

Silver-Bronze 
The Best of the Trans-Mississippi Philatelic Society, 1934–2008, 

Gregory Frantz, editor
The Philatelic Filmography, Howard Summers, author
The History of the Cayman Islands Post Offices, Ivan Burges; 

Steven Zirinsky, author 

Periodicals 
Gold 
The American Revenuer, Volume 61, American Revenue 

Association; Kenneth Trettin, editor 
German Postal Specialist, Germany Philatelic Society; James W. 

Graue, editor
First Days, AFDCS; Richard L. Sine, editor
The Israel Philatelist, SIP; Donald A. Chafetz, editor
Japanese Philately, ISJP; Robert M. Spaulding, editor

Mexicana, Mexico Elmhurst Philatelic Society International; 
Michael D. Roberts, editor

The Penny Post, Carriers and Locals Society; Larry Lyons, editor
Postal History Journal, Postal History Society; Diane De Blois 

and Robert Dalton Harris, editors
The Posthorn, Scandinavian Collectors Club; Paul Albright, editor
Ukrainian Philatelist, Ukrainian Philatelic and Numismatic 

Society; John C. Roberts, editor

Vermeil 
Bermuda Post, Bermuda Collectors Society; Nigel Shanks, editor
The Canadian Connection, Volume 21, Canadian Study Unit; 

John G. Peebles, editor
El Salvador Filatelico, El Salvador Philatelic Society, Guillermo 

Gallegos, editor
Henry Clay Stamp Notes, Henry Clay Philatelic Society; John 

Cropper, editor
Journal of the United Nations Philatelists, United Nations 

Philatelists, Inc.; Richard Powers, editor
Menelik’s Journal, Ethiopian Philatelic Society; Ulf J. Lindahl, editor
Netherlands Philately, Netherlands Philatelists of California; 

Hans Kremer, editor
Philatélie Quebec, www.philateliequebec.com; Les Editions 

DDR, editor
Postal Stationery Collector, Volume 13, Postal Stationery Society 

of Australia; Ian McMahon, editor
Reflections, Ebony Society of Philatelic Events and Reflections; 

Dan Neal, editor
Stamp Insider, Federation of New York Philatelic Societies; 

Albert W. Starkweather, editor
Texas Postal History Society Journal, Tom Koch, editor

Silver 
The Alaskan Philatelist, Alaska Collectors Club; Eric Knapp, editor
Badger Postal History, Wisconsin Postal Historical Society; Ken 

Grant and Bill Robinson, editors
Cat Mews, Cats on Stamps Study Unit; Marci Jarvis, editor
The COROS Chronicle, Collectors of Religion on Stamps; 

Augustine H. Serafini, editor
The EFO Collector, Errors, Freaks & Oddities Collectors’ Club; 

Cemil Betanov, editor
The Levant, Ottoman and Near East Philatelic Society, Richard B. 

Rose, editor
The Manchester Philatelist, Manchester (CT) Philatelic Society; 

Anthony F. Dewey, editor
Mourning Notes, Mourning Stamps and Covers Club; Elmer 

Cleary, editor
The Old World Archaeologist, Old World Archaeological Study 

Unit; Caroline Scannell, editor
Postal Himal, Nepal and Tibet Philatelic Study Circle; Richard 

M. Hanchett, editor
The Vermont Philatelist, VPS; John Lutz, editor
Upland Goose, Falklands Philatelic Society, Bill Featherstone, editor

Silver-Bronze 
From Cover to Cover, Art Cover Exchange, Joseph K. 

Doles, editor	 ✒
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Suggestions for Literature Competition Entrants
By John M. Hotchner

Experience is the best teacher. Having worked on two litera-
ture juries this year, the experience has taught me that every 

producer of philatelic literature — be it a book, society journal, 
catalogue, monograph, or club newsletter — needs to include a 
clear goal statement. It can be informal — a few sentences in the 
author’s or editor’s preface of a book or catalogue or a formal 
statement arrived at by consensus among club officers.

It is important to have such a statement for literature juries 
who need to know the benchmark the author or editor is work-
ing toward. It is even more important for authors and editors to 
have thought out what they are attempting to do. For instance, 
a journal that is understood to be one of record reflecting the 
history of a society suggests content should include activities, 
photographs with people clearly identified, and brief reports on 
what happened at meetings immediately preceding each issue.

If a major reason for producing a catalogue is to provide reli-
able pricing information in a single resource, the editor must take 
special care to explain how prices were determined. Generally it 
should not refer readers to other volumes for essential informa-
tion about material closely allied to that in the present volume.

Society publications often need to be clear about what they 
are covering in time and geography. Does the Netherlands society 
include current and past Dutch colonies in its purview? Does the 
Italian society include the period prior to confederation?

In summary, knowing what you are aiming for is the first 
step in getting there.

The second lesson from my judging experiences is that lit-
erature entrants would help themselves and help juries by pro-
viding a synopsis — very much like those prepared for stamp/
cover exhibits.

What To Include
Included should be:

•	 The goal statement and how well you think you have done in 
meeting it.

•	 Any special difficulties overcome in the past couple of years — 
changes in editorial staff, moving to color, changes in length 
or frequency, etc.

•	 Defending practices that judges in the past have questioned, 
where you think the criticisms were not warranted.

•	 The track record in prior shows.
•	 The size of your sponsoring organization, which has a bear-

ing on financial resources available for production.
•	 For books and monographs, inlcude how long has the proj-

ect been in progress and the availability of source material 
needed in their preparation.
This is not meant to be an exhaustive list, but just some 

of the information the judges may want to know. There is no 
present requirement that you provide such a document. This 
is simply a suggestion.	 ✒

Society Awards for Best Articles
By Alan Warren

Several philatelic societies offer awards for the best article pub-
lished during the preceding calendar year in their journal. These 

encourage writers to submit badly needed articles.
The Military Postal History Society has presented its best article 

award to Don Kochi for “One Lucky USS Juneau Sailor” in the fall 
2007 MPHS Bulletin. He tells of a sailor thought to have died when 
the Juneau was torpedoed on November 13, 1942. It sank quickly, 
having only 10 survivors. Mail addressed to John M. Thompson was 
returned without explanation. It turned out that he had been trans-
ferred to the USS Lackawanna just before the sinking.

Alfred Kugel won the Germany Philatelic Society’s George Bli-
zil Memorial Literature Award for his 2007 article about the Ger-
man airship base at Jamboli, Bulgaria in the June 2007 German 
Postal Specialist. He describes the base at Jamboli, Bulgaria and 
discusses the zeppelin L 59 that was loaded with supplies for the 
troops in German East Africa. During the flight it received a false 
message that caused it to return to Jamboli.

The American First Day Cover Society’s annual Philip H. Ward, 
Jr. Memorial Award, named for the Philadelphia collector, dealer, 
journalist, and pioneer in servicing FDCs, is for the best article 
showing outstanding first day cover writing and research. Although 
articles from other journals may be entered, those appearing in the 
AFDCS magazine, First Days, during the preceding calendar year 

are automatically considered. The winner is Robert Lewin for “The 
Magnificent Covers of Ejgil J. S. Halvorsen” in the December 2007 
First Days. He uncovered new information and previously unre-
corded covers by Halvorsen, who possibly created the earliest hand-
painted cachets beginning in the early 1920s. Runner-up was Ralph 
Nafziger for his September article, “The Harris–Hoffman Connec-
tion.” He describes how Marvin Harris and Michael Hoffmann be-
gan producing their own cachets and then worked together in the 
late 1950s and 1960s to issue the Diamond and Lone Star cachets.

The Universal Ship Cancellation Society presents two annual 
Honeyman awards for articles in its journal, USCS Log. One is for 
the best article that deals with naval or maritime history. The other  
is for the best article on naval/maritime postal history or philately. 
The awards are named for Stanton Honeyman, a longtime member 
and a past president of the society and editor of the journal.

The Scandinavian Collectors Club presents its Frederick A. 
Brofos award for the best article in its journal, The Posthorn. The 
award is named after a former editor of the magazine.

The United States Stamp Society offers its Walter W. Hopkin-
son Memorial Award for the best article reflecting scholarship 
and research to appear in its journal The United States Specialist. 
The society also sponsors the annual Barbara R. Mueller award 
for the best article appearing in the American Philatelic Society’s 
American Philatelist. The first winners are co-authors Steven J. 
Berlin and James W. Milgram for “Early Mail Robberies in the 
United States,” which appeared in the November 2007 AP.	 ✒
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	 October 20, 2008

New Members
1957	 Robert F. Welt, 18 Boulder Court, Mystic, CT 06344-1202. 

Columnist: “Hands on History” (Global Stamp News). Sponsor: 
George Griffenhagen.

1958	 Scott A. Shaulis, 3955 Hickory Hill Road, Murrysville, PA 
15668-9543. Editor: Permit Patter (Mailer’s Postmark Permit 
Club); Columnist: “Becoming A Stamp Dealer” (American 
Stamp Dealer & Collector). Sponsor: Peter Mosiondz. 

1959	 Robert G. Rufe, 119 Meriden Drive, Hockessin, DE 19707. 
Freelance writer: U.S. Specialist. Sponsor: Alan Warren.

1960	 Rufus W. Wilson, RR3, Box 28-1, Dalton, PA 18414. Editor: 
Philatelic Inquirer (Northeast Pennsylvania Philatelic Society); 
Columnist: “Iceland Notes” (Scandinavian Philatelic Society). 
Sponsor: Jane Fohn.

Change of Address
1662	 Alvin R. Kantor, 2430 76th Avenue, S.E., Mercer Island,  

WA 98040-3351.
1838	 James Bryan Berryhill, Jr., 104 Palomino Crossing, Wood-

way,  TX 76712-8885.

Contibutions
We thank the following for a generous contribution over and 
above the payment of their 2009 membership dues.
0113	 Charles J. Peterson, Laurel, Maryland ($7.00)

WU #30 Board Meeting
The Writers Unit #30 Board will have its bi-iannual meeting 
at 10 a.m. on February 22 during APS AmeriStamp Expo / 
Texpex. The meeting will follow the WU #30 breakfast at the 
Sheraton Arlington Hotel in Arlington, TX. See breakfast ad-
vertisement on page 3.

Secretary–Treasurer’s

Report
About Writers Unit #30
The purpose of the Writers Unit #30 of the American Philatelic 
Society is to encourage and assist philatelic communication, 
knowledge, and comradeship. Membership is open to any phila-
telic writer, columnist, editor, or publisher, as well as anyone in-
terested in philatelic communication. 

Join Us Today
Join Writers Unit #30 today and begin reaping the many ben-
efits of membership, including your subscription to The Phila-
telic Communicator.

Applications received before October 1 will be recorded as 
members for that calendar year and these members will receive 
all four issues of The Philatelic Communicator for the cal-
endar year.

Applications received on or after October 1 will be recorded as 
members for the following calendar year.

An application may be downloaded at www.wu30.org.

Membership Dues
USPS ZIP Code Addresses............................................ $15.00
 Canada and Mexico...................................................... $17.50
 All Other Addresses...................................................... $20.00
Payment must be made in U.S. funds by a check imprinted 

with a U.S. bank transit number, or by postal money order, pay-
able to APS Writers Unit #30. Some overseas members prefer to 
send U.S. bank notes by certified mail.

Updating Your Mailing Address
Please notify us of address changes to assure that you receive 
each issue of The Philatelic Communicator without delay. 
This will also save WU #30 more than $1.00 because the USPS 
charges 50 cents when they have to send us an address correc-
tion, and we still have to pay the postage for reshipping the issue 
to the member.

George B. Griffenhagen
WU #30 Secretary-Treasurer

2501 Drexel St.
Vienna, VA 22180-6906

ggriffenhagen@akphanet.org

Philatelic Communicator Advertising Rate Card
We can accept camera-ready copy or create an ad for you.

Full Page — $80 • 7.33 × 10 inches; 44 × 60 picas
Half Page — $55 • Vertical 3.6 × 9.5 inches; 21p6 × 57 picas;

Horizontal 7.33 × 4.7 inches, 44 × 28p6 picas
Quarter Page — $35 • 3.6 × 4.6 inches, 21p6 × 28p6 picas

Deadlines January 15, April 15, July 15, October 15
Contact the editor at 813-962-7964; e-mail astarkweather@wu30.org
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